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Chapter 435

Tests for Two
Exponential Means
Introduction
This program module designs studies for testing hypotheses about the means of two exponential distributions.
Such a test is used when you want to make a comparison between two groups that both follow the exponential
distribution. The responses from the samples are assumed to be continuous, positive numbers such as lifetime.
We adopt the basic methodology outlined in the books by Bain and Engelhardt (1991) and Desu and Raghavarao
(1990).

Technical Details
The test procedure described here makes the assumption that lifetimes in each group follow an exponential
distribution. The densities of the two exponential distributions are written as
f i (t ) =

 t
exp −  , i = 1,2
θi
 θi 
1

The parameters θi are interpreted as the average failure times, the mean time to failure (MTTF), or the mean time
between failures (MTBF) of the two groups. The reliability, or the probability that a unit continues running
beyond time t, is

Ri ( t ) = e

−

t

θi

Hypothesis Test
The relevant statistical hypothesis is H 0 : θ1 / θ2 = 1 versus one of the following alternatives: H A : θ1 / θ2 = ρ > 1 ,
H A : θ1 / θ2 = ρ < 1 , or H A : θ1 / θ2 = ρ ≠ 1 . The test procedure is to reject the null hypothesis H 0 if the ratio of the
observed mean lifetimes ρ = θ / θ is too large or too small. The samples of size n are assumed to be drawn
1

i

2

without replacement. The experiment is run until all items fail.
If the experiment is curtailed before all n1 + n2 items fail, the sample size results are based on the number of failures
r1 + r2 , not the total number of samples n1 + n2 .
The mean lifetimes are estimated as follows

θi =

∑t
over j

ri

ij

, i = 1,2
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where tij is the time that the jth item in the ith group is tested, whether measured until failure or until the study is
completed.
Power and sample size calculations are based on the fact that the estimated lifetime ratio is proportional to the F
distribution. That is,

θ1 θ1
~ Fr , r
θ2 θ2 1 2
which, under the null hypothesis of equality, becomes

θ1
~ Fr1 , r2
θ2
Note that only the actual numbers of failures are used in these distributions. Hence, we assume that the experiment is
run until all items fail so that ri = ni . That is, the sample sizes are the number of failures, not the number of items.
Enough units must be sampled to ensure that the stated number of failures occur.

Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that you will be concerned with.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters. Under most situations, you will
select either Power or Sample Size.
Select Sample Size when you want to calculate the sample size needed to achieve a given power and alpha level.
Select Power when you want to calculate the power of an experiment.

Test
Alternative Hypothesis
Specify the alternative hypothesis of the test. Since the null hypothesis is equality (a difference between theta1
and theta2 of zero), the alternative is all that needs to be specified.
Note that the alternative hypothesis should match the values of Theta1 and Theta2. That is, if you select Ha:
Theta1 > Theta, then the value of Theta1 should be greater than the value of Theta2.
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Power and Alpha
Power = 1–Beta (Beta is Consumer’s Risk)
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis,
and is equal to one minus Beta. Beta (consumer’s risk) is the probability of a type-II error, which occurs when a
false null hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null
hypothesis of equal thetas when in fact they are different.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected. In this procedure, a type-I error occurs when you reject the null hypothesis of equal
thetas when in fact they are equal.
Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that
about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents
the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size (When Solving for Sample Size)
Group Allocation
Select the option that describes the constraints on N1 or N2 or both.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each group. Since you are solving for both
sample sizes at once, no additional sample size parameters need to be entered.

•

Enter N1, solve for N2
Select this option when you wish to fix N1 at some value (or values), and then solve only for N2. Please note
that for some values of N1, there may not be a value of N2 that is large enough to obtain the desired power.

•

Enter N2, solve for N1
Select this option when you wish to fix N2 at some value (or values), and then solve only for N1. Please note
that for some values of N2, there may not be a value of N1 that is large enough to obtain the desired power.

•

Enter R = N2/N1, solve for N1 and N2
For this choice, you set a value for the ratio of N2 to N1, and then PASS determines the needed N1 and N2,
with this ratio, to obtain the desired power. An equivalent representation of the ratio, R, is
N2 = R * N1.

•

Enter percentage in Group 1, solve for N1 and N2
For this choice, you set a value for the percentage of the total sample size that is in Group 1, and then PASS
determines the needed N1 and N2 with this percentage to obtain the desired power.
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N1 (Sample Size, Group 1)
This option is displayed if Group Allocation = “Enter N1, solve for N2”
N1 is the number of items or individuals sampled from the Group 1 population.
N1 must be ≥ 2. You can enter a single value or a series of values.
N2 (Sample Size, Group 2)
This option is displayed if Group Allocation = “Enter N2, solve for N1”
N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.
R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter R = N2/N1, solve for N1 and N2.”
R is the ratio of N2 to N1. That is,
R = N2 / N1.
Use this value to fix the ratio of N2 to N1 while solving for N1 and N2. Only sample size combinations with this
ratio are considered.
N2 is related to N1 by the formula:
N2 = [R × N1],
where the value [Y] is the next integer ≥ Y.
For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1 (e.g., N1 =
10 and N2 = 20, or N1 = 50 and N2 = 100).
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single or a series of values.
Percent in Group 1
This option is displayed only if Group Allocation = “Enter percentage in Group 1, solve for N1 and N2.”
Use this value to fix the percentage of the total sample size allocated to Group 1 while solving for N1 and N2.
Only sample size combinations with this Group 1 percentage are considered. Small variations from the specified
percentage may occur due to the discrete nature of sample sizes.
The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single or a series of values.

Sample Size (When Not Solving for Sample Size)
Group Allocation
Select the option that describes how individuals in the study will be allocated to Group 1 and to Group 2.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each group. A single per group sample
size will be entered.

•

Enter N1 and N2 individually
This choice permits you to enter different values for N1 and N2.
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•

Enter N1 and R, where N2 = R * N1
Choose this option to specify a value (or values) for N1, and obtain N2 as a ratio (multiple) of N1.

•

Enter total sample size and percentage in Group 1
Choose this option to specify a value (or values) for the total sample size (N), obtain N1 as a percentage of N,
and then N2 as N - N1.

Sample Size Per Group
This option is displayed only if Group Allocation = “Equal (N1 = N2).”
The Sample Size Per Group is the number of items or individuals sampled from each of the Group 1 and Group 2
populations. Since the sample sizes are the same in each group, this value is the value for N1, and also the value
for N2.
The Sample Size Per Group must be ≥ 2. You can enter a single value or a series of values.
N1 (Sample Size, Group 1)
This option is displayed if Group Allocation = “Enter N1 and N2 individually” or “Enter N1 and R, where N2 =
R * N1.”
N1 is the number of items or individuals sampled from the Group 1 population.
N1 must be ≥ 2. You can enter a single value or a series of values.
N2 (Sample Size, Group 2)
This option is displayed only if Group Allocation = “Enter N1 and N2 individually.”
N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.
R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter N1 and R, where N2 = R * N1.”
R is the ratio of N2 to N1. That is,
R = N2/N1
Use this value to obtain N2 as a multiple (or proportion) of N1.
N2 is calculated from N1 using the formula:
N2=[R x N1],
where the value [Y] is the next integer ≥ Y.
For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1.
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single value or a series of values.
Total Sample Size (N)
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”
This is the total sample size, or the sum of the two group sample sizes. This value, along with the percentage of
the total sample size in Group 1, implicitly defines N1 and N2.
The total sample size must be greater than one, but practically, must be greater than 3, since each group sample
size needs to be at least 2.
You can enter a single value or a series of values.
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Percent in Group 1
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”
This value fixes the percentage of the total sample size allocated to Group 1. Small variations from the specified
percentage may occur due to the discrete nature of sample sizes.
The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single value or a series of
values.

Effect Size
Theta1 (Group 1 Mean Life)
Enter one or more values for the mean life of group 1 under the alternative hypothesis. This value is usually scaled
in terms of elapsed time such as hours, days, or years. Of course, all time values must be on the same time scale.
Note that the value of theta may be calculated from the estimated probability of failure using the relationship

P( Failure) = 1 − e − time/θ
so that

θ=

− time
ln(1 − P( Failure))

Any positive values are valid. You may enter a range of values such as ‘10 20 30’ or ‘100 to 1000 by 100.’
Note that only the ratio of theta1 and theta2 is used in the calculations.
Theta2 (Group 2 Mean Life)
Enter one or more values for the mean life of group 2 under the alternative hypothesis. This value is usually scaled
in terms of elapsed time such as hours, days, or years. Of course, all time values must be on the same time scale.
Note that the value of theta may be calculated from the estimated probability of failure using the relationship

P( Failure) = 1 − e − time/θ
so that

θ=

− time
ln(1 − P( Failure))

Any positive values are valid. You may enter a range of values such as ‘10 20 30’ or ‘100 to 1000 by 100.’
Note that only the ratio of theta1 and theta2 is used in the calculations.
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Example 1 – Power for Several Sample Sizes
This example will calculate power for several sample sizes of a study designed to compare the average failure
time of (supposedly) identical components manufactured by two companies. Management wants the study to be
large enough to detect a ratio of mean lifetimes of 1.3 at the 0.05 significance level. The analysts decide to look at
sample sizes between 5 and 500.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Tests for Two Exponential Means procedure window by expanding Means, then Two
Independent Means, then clicking on Non-Normal Data, and then clicking on Tests for Two Exponential
Means. You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu
and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Alternative Hypothesis ............................ Ha: Theta1 ≠ Theta2
Alpha ....................................................... 0.05
Group Allocation ..................................... Equal (N1 = N2)
Sample Size Per Group .......................... 5 20 50 100 200 300 400 500
Theta1 (Group 1 Mean Life) ................... 1.3
Theta2 (Group 2 Mean Life) ................... 1.0

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results
H0: Theta1 = Theta2. Ha: Theta1 ≠ Theta2.
Power
0.06652
0.12839
0.25602
0.45619
0.74551
0.89447
0.95976
0.98559

N1
5
20
50
100
200
300
400
500

N2
5
20
50
100
200
300
400
500

N
10
40
100
200
400
600
800
1000

Theta1
1.3
1.3
1.3
1.3
1.3
1.3
1.3
1.3

Theta2
1.0
1.0
1.0
1.0
1.0
1.0
1.0
1.0

Theta1/
Theta2
1.300
1.300
1.300
1.300
1.300
1.300
1.300
1.300

Alpha
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050

Report Definitions
Power is the probability of rejecting a false null hypothesis.
N1 and N2 are the number of failures needed in Groups 1 and 2.
N is the total sample size, N1 + N2.
Theta1 and Theta2 are the Mean Lifes in Groups 1 and 2 at which power and sample size calculations are made.
Theta1 / Theta2 is the simple ratio of Theta1 to Theta2.
Alpha is the probability of rejecting a true null hypothesis.

435-7
© NCSS, LLC. All Rights Reserved.

PASS Sample Size Software

NCSS.com

Tests for Two Exponential Means
Summary Statements
Samples of size 5 and 5 achieve 7% power to detect a difference between the mean lifetime in
group 1 of 1.3 and the mean lifetime in group 2 of 1.0 at a 0.05000 significance level (alpha)
using a two-sided hypothesis based on the F distribution.

This report shows the power for each of the scenarios.

Plots Section

This plot shows the relationship between power and sample size.
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Example 2 – Validation using Manual Calculations
We could not find published results that could be used to validate this procedure. Instead, we will compare the
results to those computed using our probability distribution calculator.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Tests for Two Exponential Means procedure window by expanding Means, then Two
Independent Means, then clicking on Non-Normal Data, and then clicking on Tests for Two Exponential
Means. You may then make the appropriate entries as listed below, or open Example 2 by going to the File menu
and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Alternative Hypothesis ............................ Ha: Theta1 > Theta2
Alpha ....................................................... 0.05
Group Allocation ..................................... Equal (N1 = N2)
Sample Size Per Group .......................... 20
Theta1 (Group 1 Mean Life) ................... 1.3
Theta2 (Group 2 Mean Life) ................... 1.0

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results
H0: Theta1 = Theta2. Ha: Theta1 > Theta2.
Power
0.20369

N1
20

N2
20

N
40

Theta1
1.3

Theta2
1.0

Theta1/
Theta2
1.300

Alpha
0.050

We will now check these results using manual calculations. First, we find critical value
F0.95,40, 40 = 1.6927972097

using the probability calculator. Now, to calculate the power, we find the inverse F of 1.6927972097/1.3 =
1.302152 to be 0.79631. One minus 0.79631 is 0.20369, which matches the reported value of Power.
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